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Excel Intermediate

Creating Formulas

Using a formula can help you analyse data on a worksheet.
With a formula you can perform operations, such as addition
and multiplication. Think of a formula as one side of an
equation whose result is shown in the cell.

An Excel formula always begins with an equal sign (=).
Arithmetic Operators

+ Addition - Subtraction

/ Division * Multiplication
%  Percent A Exponentiation
Examples

=B4+B8 =C6*12.5%

=C9/9 =742-741

=20"2*.15 =(B6*5)+C5

Note: You can use Excel as a calculator if
required. eg. =56"49

Notes:
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Excel Intermediate

Functions

A function is a built-in formula that takes a value
or values, performs an operation and returns a
value. The values that you give to a function are
called arguments.

For example, instead of typing the formula
=B1+B2+B3

you can use the SUM function to build the formula
=SUM(B1:B3)

Note: When you use the AutoSum button Excel types the
function for you and even suggests the range of cells you want
to add.

To access the function list choose the Function Wizard button

or select Insert Function. The Help button in the Function
Wizard is especially useful to give a full description and
example of any function.

Some commonly used functions:

= AVERAGE returns the average of its arguments
= TODAY() displays current date calculated from the
= NOW () computer’s clock
= MAX returns the minimum value in a list of
arguments
= PMT
=IF
Notes:
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Excel Intermediate

Linking Worksheets

You can link a formula in a worksheet to source data located in
another worksheet so that any changes you make to

the source data are |mmed|ately reflected in the

linked formula.

Linking One Cell
1. Select a cellin

the Target
worksheet.

2. Type an = sign to
start a formula.

3. Select the cell in the Source worksheet.
4. Press Enter.

Linking a Range of Cells

1. From the Source worksheet select the range you
would like to use.

. Choose Edit Copy.

. Select the Target worksheet.
. Choose Edit Paste Special.

. Select Paste Link.

Removing Links
1. Copy the cell(s) containing the \
formula.
2. Choose Edit Paste

Special.

a A ODN

3. Select the Values
option button.

E Note: Another way to link is to use the camera tool. See

customising toolbars.

Notes:
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Excel Intermediate

Goal Seek

Select a cell with a formula

From the Tools Menu select Goal Seek
Select a value

Select the changing cell

PN~

Goal Seek

Set cel: |86 y
To value: |5EIIZ|

Ey changing cell: |$B44] EY

(04 | Zancel |

Remember you can Undo if you need to.

Notes:
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Excel Intermediate

Styles & Templates

Styles

A quick way to format an entire worksheet is to use the Format

Style menu.

Style

Stwle name:

0]%

~akwle includes
¥ Mumber

v alignment
v Faont

v Eorder
v Patterns

i~ Prokection

General

General, Bottom Aligned
Arial 10

Mo Borders

Mo Shading

Locked

Cancel

Flile

Madify. ..

Add
Delete

Merge...

Il

Select Modify and make any changes. The default for the
entire sheet will change.

You can also do this by using the Style drop down menu. See

customising
toolbars.

Format a cell

Foma (3]

Style

as you normally would. Select the style you want to redefine
eg Normal. Choose OK.

Notes:
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Excel Intermediate

Templates

If you have a set of styles, formulas, layouts that you would like
to use again save your workbook as a template.

Select File Save As and choose Template under File Type.
The extension will be .xlIt. In order to use the template close
the file. Reopen by selecting the file with the .xIt extension.
You may now make any changes and save this file as an Excel
Workbook. You may reuse the template as many times as you
like.

Conditional Formatting

Applies formats to selected cells based on criteria that you
specify.

1. Select the cell or cells you wish to format
2. From the Format Menu select Conditional Formatting

Conditional Formatting

ondition 1
Cell value Is j |greater than ﬂ |5|:||:|
Prewiew of Format to use AaBbCcYyZz
when condition is krue:

Add == | Delete, .. Ok | Cancel |

Notes:
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Excel Intermediate

Creating Charts

1. Select the cells that contain the data you want to use
for your chart.

2. Click Chart Wizard. 8
3. Follow the instructions in the Chart Wizard.

Standard Types | Custom Tvpes I

Chart tvpe: Chart sub-type:
. RBY (Scatker)
by Area | |
@ Doughnut 4 UL
@r Radar ——
e surface s
@ Bubble
| Stock LI
Clustered Column, Compares values across
cateqories.,
Press and Hold to Yiew Sample ]

Cancel | Mext = | Finish |

Notes:
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Excel Intermediate

Range Names & GoTo
In the top left corner of your spreadsheet is a drop down Name
box.
Al . Select any cell or range of cells and go

—_— to the Name Box. Type in a name e.g.
JNameBox [ B January and press Enter.

;_:. The name has to be one word so if you

want two words connect using an
3 underscore eg January_2004

Use the Name Box to GoTo any cell or Range Name. F5 is
another useful shortcut.

Notes:
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Excel Intermediate

Lookup Functions
LOOKUP

The LOOKUP function has two syntax
forms, vector and array. A vector is

an array that contains only one row or
one column. The vector form of
LOOKUP looks in a vector for a value,
moves to the corresponding position in
a second vector, and returns this value.
Use this form of the LOOKUP function
when you want to be able to specify the
range that contains the values you
want to match. The other form of
LOOKUP automatically looks in the
first column or row.

Important The values must be
placed in ascending order: ...,-2, -
1,0,1, 2, ..., A-Z, FALSE, TRUE;
otherwise, LOOKUP may not give
the correct value.

Note: If LOOKUP can't find the lookup_value, it uses the
largest value in the array that is less than or equal to
lookup_value.

HLOOKUP and VLOOKUP allow you to index down or across,
but LOOKUP always selects the last value in the row or
column.

HLOOKUP  Looks in the top row of an array and returns the
value of the indicated cell.

VLOOKUP  Looks in the first column of an array and moves
across the row to return the value of a cell.

Exercise

A | B |
_1 [Frequency Colour
2 4.14 red
3| 4.18]  arange
4 817 yellow
9| 877 green
6 | 5.39 hlue
| 7.32 winlet

Under the Lookup & Reference Category in the Function
Wizard select Lookup
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Excel Intermediate

= Function Wizard - Step 1a of 2
LOOKUP

Thiz function has multiple argument listz. Pleaze zelect one of them.
Arquments:

lookup_value. array

Help I| Cancel II oK |

Select the first option

OOKLP
Lookup_value || ik_] =
Lookup_vector I ] =
Result_veckor I ik_] =
o =

eturns a walue either From a one-row or one-column range or From an array,

Lookup_walue is a value that LOOKUP searches for in Lookup_vector and can be a
number, kext, alogical walue, ar a name or reference ko a walue.,

@ Forrnula result = Ok I Cancel

[X[UTA] =LOOKUP(4.91 A2:A7,B2:.68)

In the preceding worksheet:

=LOOKUP(4.91,A2:A7,B2:B7) equals "orange"
=LOOKUP(7.66,A2:A7,B2:B7) equals "violet"

Notes:
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Excel Intermediate

Outlining a Worksheet

You can outline your worksheet data to create summary
reports. With summary reports, you can show or hide as much
detail as you want.

Automatic Outlining

Automatic outlining relies on formulas.
1. Select the data you want to outline.
2. Select Data, Group and Outline

3. Choose the Auto Outline

1] r =]
. . . .
0 A | B | ¢ | b | E | F
1 QTR 1 QTR 2 QTR 3 QTR 4 TOTAL
2 |RENT 345 345 345 345 1380
3 |PHONE 47 146 220 120 f33
4 (POVWER 344 555 ] 432 1937
5 [ENTERTAIMMEMT 345 b=t 340 545 1997
6 (TOTAL 1081 1813 1561 1442 atuie ol
By selecting the button labelled [ you can show one
level revealing the headings and total. You can also
hide the rows by selecting the & button.
1] r =
] ] ] ]
[0 A | B | ¢ | b | E | F
1 QTR A QTR 2 QTR 3 QTR 4 TOTAL
[+ TOTAL 1081 1813 1861 1442 897
Notes:
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Excel Intermediate

Removing an Outline

You can remove a portion of an outline or an entire outline

from your worksheet.
To remove

Do this

A portion of an outline

The entire outline

—a

s

1. Select the rows or columns
from which you want the
data removed.

2. Choose the Group and
Outline command from the
Data menu.

3. Choose the Clear Outline
Command.

Select the entire outlined
range. Follow steps 2 & 3
above.

Note: To turn the outline symbols off/on without clearing
the outline use this icon in the Utilities category when

customising your toolbars.

Notes:
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Excel Intermediate

Adding Comments

You can attach text to a cell containing a value that needs
explanation, or to a cell containing a complex formula that you
want to document for future reference.

1. Select the cell to document.

2. Right click to Insert Comment. | '3
A red triangle at the top right corner of
the cell will appear indicating a note. “*TLibby Baker:
If this does not appear select Tools, Yada, yada, vada

Options, View, Comment Indicator.

Printing Comments

1. In the Page Setup menu choose the Sheet Tab.
2. Select Comments.

3. If you want a cell reference attached to the Note
choose Row and Column headings.

Notes:
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Excel Intermediate

Hiding & Protecting Worksheets

Hiding Modules

If you have written a macro that you would like to hide select
Edit Sheet Hide. When you select a macro to edit it is
automatically “Unhidden.”

Hiding Worksheets

While writing macros you may choose to hide worksheets and
the command is slightly different. Choose Format Sheet Hide.
You may also Unhide sheets and modules from the same
menu.

Notes:
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Excel Intermediate

Protecting Workbooks & Sheets
Restricting Access

¢ Preventing workbooks from
being opened or saved

¢ Protecting formulas, objects,
headings

¢ Hiding a Workbook, selected
sheets, rows, or columns

¢ Preventing formulas from appearing in the formula bar

Requiring a Password When a Workbook is Opened
1. Open the workbook.
2. Choose File Save As.
3. Choose the Options button.
4

. In the Protection Password box, type a
password.

5. Choose OK
6. Retype the password.
7. Choose OK.

[ Alwapsz Create Backup
File Sharing
Protection Password: |““

Write Reservation Password: I Help I
[” Read-Only Recommended

Note: Passwords are case sensitive. If you forget the
password , you cannot open the workbook.

Requiring a Password When a Workbook is Saved
For Look but Don’t Touch access.
Follow the previous steps but type the password in the Write
Reservation Box. Alternatively you can choose Read-Only

Recommended. This allows a user to save a copy but the
original workbook remains unchanged.
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Excel Intermediate

Removing Passwords

1. Open the workbook.
2. Choose File Save As and Options.
3. Press the Delete key to remove password(s).

Protecting an area of your Worksheet

You might want to prevent changes to some cells and leave
other cells unlocked ie. formulas.

1. Select the cells that you want to allow changes
or entries to.

2. Select Format Cells and the Protection Tab.

= Format Cells

M umber T Aligrmnent T Fiont T Border T Patterms T ‘

[® Locked
[ Hidden Cancel

Locking cellz or hiding formulas has no effect unless
the workzheet iz protected. To protect the workzheet,
chooze Protection from the Toolz menu, and then
chooze Protect Sheet. A password is optional.

1. Clear the Locked check box.

2. From the Tools menu select Protection, Protect
Sheet.

3. A password is optional.

Note: You can use the Tab key to move between unlocked
cells on a protected worksheet.

Notes:
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